Information in this document is subject to change without notice and does not represent a commitment on the part of the vendor or its representatives. No part of this document may be reproduced or transmitted in any form or by any means, electronic or mechanical, including photocopying, without the written permission of Pitney Bowes Inc.

© 2019 Pitney Bowes. All rights reserved. MapInfo, the MapInfo logo and Confirm are trademarks of Pitney Bowes and/or its affiliates.

Corporate contact details for all offices can be found here:

Technical Support contact details can be found here:
https://www.pitneybowes.com/us/contact-dcs.html

Products named herein may be trademarks of their respective manufacturers and are hereby recognized. Trademarked names are used editorially, to the benefit of the trademark owner, with no intent to infringe on the trademark.

Open Source Attribution Notice

The Confirm suite of products contain the following open source software:

- Feature Data Objects v 3.5.0, which is licensed under GNU Lesser General Public License, Version 2.1, February 1999 with the unRAR restriction. The license can be downloaded from: http://fdo.osgeo.org/licenceAndGovernance.html. The source code for this software is available from http://fdo.osgeo.org/content/fdo-350-downloads

- MrSID software (specifically the mrsid32.dll) is used under license and is Copyright © 1995-2002, LizardTech, Inc., 1008 Western Ave., Suite 200, Seattle, WA 98104. All rights reserved. MrSID is protected by U.S. Patent No. 5,710,835. Foreign patents are pending. Unauthorized use or duplication prohibited.

Patented technology in the Software was developed in part through a project at the Los Alamos National Laboratory, funded by the U.S. Government and managed by the University of California. The U.S. Government has reserved rights in the technology, including a non-exclusive, nontransferable, irrevocable, paid-up license to practice or have practiced throughout the world, for or on behalf of the United States, inventions covered by the patent, and has other rights under 35 U.S.C. § 200-212 and applicable implementing regulations.

For further information, contact Lizardtech.

- NodaTime, version number 1.3.10, which is licensed under the Apache license, version number 2.0. The license can be downloaded from http://www.apache.org/licenses/LICENSE-2.0. The source code for this software is available from http://nodatime.org/

- Chromium Embedded Framework, version 3, which is licensed under the New BSD License. The license can be downloaded from http://opensource.org/licenses/bsd-3-Clause. The source code for this software is available from http://code.google.com/p/chromiumembedded/downloads/list.

- Xilium.CefGlue, version 3, which is licensed under the MIT License (with portions licensed under the New BSD License). The licenses can be downloaded from http://opensource.org/licenses/MIT and http://opensource.org/licenses/bsd-3-Clause. The source code for this software is available from http://xilium.bitbucket.org/cefglue/

- D3 Data Driven Documentation, version 3.4.1, which is licensed under the New BSD License. The license can be downloaded from https://github.com/mbostock/d3/blob/master/LICENSE. The source code for this software is available from http://d3js.org/

- OpenLayers, version 2.12, which is licensed under the Modified BSD License. The license can be downloaded from http://svn.openlayers.org/trunk/openlayers/license.txt. The source code for this software is available from http://trac.osgeo.org/openlayers/browser.

For further information, contact Lizardtech.

- OpenLayers, version 3, which is licensed under the BSD 2-Clause Licence. The license which can be downloaded from https://github.com/openlayers/ol3/blob/master/LICENSE.md. The source code for this software is available from https://github.com/openlayers/ol3.
• Proj4js, version 1+, which is licensed under the Apache License, Version 2, January 2004. The license can be downloaded from http://www.apache.org/licenses/LICENSE-2.0.html. The source code for this software is available from http://trac.osgeo.org/proj4js/.

• requireJS, version 2.1.2, which is licensed under the MIT License or the New BSD License. The license can be downloaded from https://github.com/jrburke/requirejs/blob/master/LICENSE. The source code for this software is available from http://requirejs.org/.

• Apache Cordova, version 8.1.2, which is licensed under the Apache License, Version 2, January 2004. The license can be downloaded from http://www.apache.org/licenses/LICENSE-2.0.html. The source code for this software is available from http://phonegap.com/download/.

April 09, 2019
# Table of Contents

## System Fundamentals

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Confirm Modules</td>
<td>6</td>
</tr>
<tr>
<td>Terminology in Confirm products</td>
<td>7</td>
</tr>
<tr>
<td>Confirm PDF Printer</td>
<td>9</td>
</tr>
<tr>
<td>Logging In</td>
<td>11</td>
</tr>
<tr>
<td>Application Login</td>
<td>11</td>
</tr>
<tr>
<td>Common Login Messages</td>
<td>12</td>
</tr>
<tr>
<td>Using Confirm</td>
<td>14</td>
</tr>
<tr>
<td>Menu</td>
<td>14</td>
</tr>
<tr>
<td>Toolbar</td>
<td>15</td>
</tr>
<tr>
<td>Confirm Explorer</td>
<td>18</td>
</tr>
<tr>
<td>User Interface</td>
<td>19</td>
</tr>
<tr>
<td>More Windows</td>
<td>21</td>
</tr>
<tr>
<td>Common Buttons</td>
<td>22</td>
</tr>
<tr>
<td>How Data is Displayed</td>
<td>28</td>
</tr>
<tr>
<td>Types of Fields</td>
<td>31</td>
</tr>
<tr>
<td>Reports &amp; Lists</td>
<td>33</td>
</tr>
<tr>
<td>The Dead flag</td>
<td>35</td>
</tr>
<tr>
<td>Importing and Exporting Data</td>
<td>35</td>
</tr>
<tr>
<td>Shortcut keys</td>
<td>35</td>
</tr>
<tr>
<td>Warnings and Errors</td>
<td>38</td>
</tr>
<tr>
<td>Changing Password</td>
<td>39</td>
</tr>
<tr>
<td>Exporting Data from Confirm</td>
<td>40</td>
</tr>
<tr>
<td>Logging Out</td>
<td>41</td>
</tr>
</tbody>
</table>
Overview

This manual explains how to log in to Confirm, use the screens which appear, run reports, and common buttons and options which the User will experience. This information is based on the Windows environment and assume that the user is familiar with common Windows features and navigational techniques.

Some General points:

- Confirm takes its general settings, such as resolution, colour schemes, and date types from the Windows settings. If, for instance a User finds Confirm showing dates in the American format (MM/DD/YY) or only displaying two digits of the year, this is because Windows has been set up to display dates in this way, and the regional settings should be altered to the preferred date format.
- Everyone using Confirm should have a unique User login. For details on how to set up Users in Confirm please see the 'System Administration' manual.
- The way in which Confirm responds, the messages it might display, and the procedures that users might follow, are to some extent dictated by their User set up and the general Security Settings in Confirm. For details on these please see the 'System Administration' manual.
Confirm Modules

Confirm is made up of modules which provide access to different functionality. Some modules are applicable to certain asset types and not to others.

The way Confirm looks, and the folders displayed to a User in the Confirm Explorer is governed by which of these modules are 'switched on' and the particular User's security. The active modules can be viewed by looking at the System Registration screen.

The System Registration screen lists all the possible modules, showing the modules that are currently active in the current Licence in bold text with a tick next to the module name.

If a User is unable to see a component that they expect to see (i.e. the module is present) they should check with the System Administrator they have granted that User the rights to that component. Rights to folders, libraries, utilities and reports are set for each User.

It is not possible to amend the System Registration without an updated access code which will be provided by Pitney Bowes.
Terminology in Confirm products

Confirm displays different terminology for screen and field names appropriate for different assets. The terminology a particular User sees is determined by default by the executable used to run Confirm. However this may be overridden at the system level by a setting on the General System Settings screen, and on a per Work Group basis on the Work Group screen. A User level override may also be specified on the General User Settings screen.

Note that the terminology does not affect the way Confirm works. For a User with Confirm Engineering terminology for instance, the first folder in the Explorer is called ‘Street Register’, whereas the Help refers to it as ‘Site Register’. ‘Street’ and ‘Site’ are the same thing as far the functionality of Confirm is concerned, and wherever ‘Site’ is referred to in the Help, it means ‘Street’ in that version of Confirm.

The Confirm Help topics are not asset specific - descriptions are given with no reference to a particular terminology. Users should be able to get all they need from the Help whether they are an Engineering User, or an Environmental User. The reader of the Help should be aware of the modules they are using, and the naming conventions which apply in their version of Confirm.

The following table explains where terminology may differ:

<table>
<thead>
<tr>
<th>Name</th>
<th>Property</th>
<th>Street</th>
<th>Street</th>
<th>Street</th>
<th>Street</th>
<th>Road</th>
<th>Street</th>
<th>Road</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site</td>
<td>Building</td>
<td>Street</td>
<td>Street</td>
<td>Street</td>
<td>Street</td>
<td>Road</td>
<td>Street</td>
<td>Road</td>
</tr>
<tr>
<td>Classifications</td>
<td></td>
<td>Network</td>
<td>Network</td>
<td>Network</td>
<td>Network</td>
<td></td>
<td>Network</td>
<td></td>
</tr>
<tr>
<td>Feature</td>
<td>Street</td>
<td>Asset</td>
<td>Street</td>
<td>Section</td>
<td>Tree</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Feature Id</td>
<td>Asset Id</td>
<td>Road Number</td>
<td>Road Number</td>
<td>Asset Id</td>
<td>Tag No</td>
<td>Label</td>
<td>Label</td>
<td>Asset ID</td>
</tr>
<tr>
<td>Plot Number</td>
<td>Asset Number</td>
<td>Section Number</td>
<td>Asset Number</td>
<td>Feature Number</td>
<td>Sequence Number</td>
<td>Sequence Number</td>
<td>Asset Number</td>
<td></td>
</tr>
<tr>
<td>Feature Type</td>
<td>Carriageway</td>
<td>Carriageway</td>
<td>Carriageway</td>
<td>Type</td>
<td>Type</td>
<td>Species</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Feature Group</td>
<td>Carriageway</td>
<td>Carriageway</td>
<td>Carriageway</td>
<td>Group</td>
<td>Group</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Property</td>
<td>Street Works</td>
<td>Street Lights</td>
<td>Highways</td>
<td>Engineering</td>
<td>Enterprise</td>
<td>Arboriculture</td>
<td>Pavement Management System</td>
</tr>
<tr>
<td>------------</td>
<td>----------</td>
<td>--------------</td>
<td>---------------</td>
<td>----------</td>
<td>-------------</td>
<td>------------</td>
<td>--------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>External Reference</td>
<td>DOT reference</td>
<td>Road Number</td>
<td>DOT reference</td>
<td>Road Number</td>
<td>Road Reference</td>
<td>Road Number</td>
<td>Road Number</td>
<td>Road Number</td>
</tr>
<tr>
<td>Gang</td>
<td>Team</td>
<td>Team</td>
<td>Team</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ledger</td>
<td>Hiwocs</td>
<td>Hiwocs</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Defect</td>
<td></td>
<td>Fault</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note:** Confirm Environmental uses the basic names, therefore it is not listed above.

**Note:** Where no entry is made in the table, that version of Confirm uses the same terms as the help, e.g. Confirm Property describes the asset as 'Feature', therefore no entry is made in the table against Feature.

**Note:** Terminology System Settings screen allows each of these terms to be overridden with a user entered value.
Confirm PDF Printer

The Confirm pdf printer is used to view\print the documents and screens of Confirm in pdf format. The printer is installed in the system as a part of Confirm installation. It can also be installed using standalone installer available at the following location in Confirm package:

`\Software\Prerequisites\PDF Printer`

Confirm PDF printer troubleshooter

Confirm pdf printer troubleshooter is a batch file which rectifies the issues related to user access level and operating system of the machine. In case where user faces problem in using the Confirm printer, the script will update machine configurations to rectify some of the known issues. The script is available in Confirm PDF printer folder in Confirm package.

In order to use the Confirm PDF printer troubleshooter, perform following steps:

1. Right click on command prompt and ‘Run as administrator’
2. Navigate to the path where pdf troubleshooter batch script is available.
3. Enter command “_PdfTroubleshooter.bat” and press ‘Enter’
4. The Trouble shooter will start and perform certain operations
5. In case all operations are performed successfully, following command should be displayed.

```
2016/12/12 1:11 PM: Troubleshooting complete. Confirm PDF Printer should work now
Press any key to exit...
```

6. After Exit, the Confirm pdf printer should work properly.
7. In case if the troubleshooter fails or the the problem still exists, please contact support.

Confirm PDF troubleshooter Work Flow
Update permissions in the Registry folders such that 'E:\\eryane' has 'Full Control' access to them.

Open Registry and check permissions to the following keys:
- HKEY_CURRENT_USER\Software
- HKEY_CURRENT_CONFIG\Software\Confirm PDF printer

Update permissions of the Registry folders such that 'Everyone' has 'Full Control' on them.

Does 'Everyone' user group has 'Full Control' on the registry?

Is Confirm pdf printer available?

Is Confirm pdf printer working properly?

Is Windows 7?

Is the port assigned to the Confirm pdf printer 'null'?

Uninstall Ml Pro from the machine.

Repair Confirm installation.

Update Confirm pdf printer port to 'null'.

Please contact support for further assistance.

Success.
Logging In

When Confirm was installed a shortcut will have been placed on the desktop and in the Start menu. Select the Confirm icon to start the application and display the 'Application Login' screen.

Application Login

The Application Login screen will be displayed when a Confirm shortcut is selected. Supply login details to access Confirm.

![Confirm Application Login Screen]

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Username:</td>
<td>Supply the Confirm Username to log in with. This field will default to the last User who accessed Confirm. It can be changed if a different Username is required.</td>
</tr>
<tr>
<td>Password:</td>
<td>Supply the Password for the User supplied in the User ID field. The characters typed in will be hidden by asterisks.</td>
</tr>
</tbody>
</table>
| Profile Name:     | Select the Confirm Profile (database) to log in to from the drop down list. The last profile to be accessed will be displayed by default. Commonly there is a 'Live' and 'Test' database available and care should be taken when logging in to make sure that the correct database has been selected.  
  - 'Live' is intended to show the currently used database which contains active data.
  - 'Test' is intended to show a copy of the database that may be used to practice, train, and run test scenarios. These databases may be overridden at regular intervals by the system administrator. |
Up to three login attempts are permitted before Confirm closes. The User can click on the Confirm shortcut again to attempt to login again.

### Common Login Messages

<table>
<thead>
<tr>
<th>Message</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Invalid UserID or Password entered, please try again.</td>
<td>This message will occur if the User has entered an incorrect User ID or Password to access Confirm. The User should speak to the System Administrator about checking their User ID or resetting their Password if they have forgotten it.</td>
</tr>
<tr>
<td>Invalid UserID or Password entered, your three tries have been used up.</td>
<td>This is message will follow on from the above message if the User has failed to log in three times. Once this message has appeared Confirm will close and the User will need to reopen Confirm to try to log in again.</td>
</tr>
<tr>
<td>Your password has expired, please enter a new password.</td>
<td>If the Security Settings have been set to expire a User password, this message will occur. The User will then be presented with the Change Password screen where they can update it before logging into Confirm.</td>
</tr>
<tr>
<td>You have been locked out of the system. Please contact your System Supervisor.</td>
<td>The Security Setting may have been set to lock the User out after a pre-set number of failed login attempts. In this case, once that number of attempts have been made, the User will see this message informing them that they have been locked out and advising them to see the System Administrator.</td>
</tr>
<tr>
<td>Maximum number of users on your licence exceeded, do you wish to see who is currently logged in?</td>
<td>If there are lots of Users already logged into Confirm, click 'No' to the message, and either wait until someone has logged out, or request someone else to log out. Occasionally, Users remain listed as 'logged in' when they are not actively using Confirm. This can happen if they did not log out properly, or encountered an error that shut down Confirm. If this is the case, click 'Yes' to view the User Reset list. All Users are able to view the User Reset screen, and to remove their own 'rogue' user sessions from the list of Users. Users with privileges to the User Reset screen will be able to reset sessions for Users other than themselves. Please see the System Administration manual for details on how to reset users.</td>
</tr>
<tr>
<td>Message</td>
<td>Explanation</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Unable to process your request. Please try later or contact System Administrator.</td>
<td>System Administration\System Configuration  This message will occur if Confirm has been migrated to Confirm Configuration Service and there is an issue with it. For information regarding troubleshooting, please refer to <strong>Confirm Configuration Service FAQ</strong> You are requested to contact your system administrator for this issue.</td>
</tr>
</tbody>
</table>
Using Confirm

Once a User has successfully entered their Username and Password, Confirm will be displayed.

The title bar displays the software name on the left hand side, together with the Login details of the User, Contractor Name (if the user is a Contractor) and the database selected on the Application Login screen. Buttons for Minimise, Maximise and Close at displayed on the right hand side.

If the current User has specified a Home Page and / or a Dashboard, this will also open next to the Confirm Explorer.

Menu

The menu provides the following items:

<p>| File: | Provides system-related options, such as the Print, Send and Exit as well as record related options such as New, Save, Delete and Restore. |</p>
<table>
<thead>
<tr>
<th><strong>Edit:</strong></th>
<th>Provides standard Windows editing functions, such as Undo, Cut, Copy and Paste. Other options from this menu include record navigation options such as First, Previous, Next and Last. ‘Copy SQL’ - can be used on most data entry windows and reports to copy the underlying SQL to the clipboard, in order to see which tables and columns are involved in a screen/report and also to use the SQL as the basis for creation of new Data Sources and Reports.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Shortcuts:</strong></td>
<td>Select from: ‘Explorer’ - Opens the Confirm Explorer. ‘Dashboard’ - Displays the current User's configured Dashboard or the Dashboard User settings if no Dashboard has been selected by the current User. Users shortcuts - All of the current User's shortcuts that have been placed in the User's Folder will be listed at the bottom of the ‘Shortcuts’ menu.</td>
</tr>
<tr>
<td><strong>Window:</strong></td>
<td>Select from: ‘Cascade’, ‘Tile Horizontal’, ‘Tile Vertical’, ‘Minimise All’ - Standard Windows functions to arrange the currently open forms in Confirm. ‘Arrange Icons’ - Arranges all minimised forms at the bottom of the Confirm workspace. ‘Close’ - Closes the currently selected form. ‘Framebar’ - Toolbar can be displayed by selecting this option. It can then be moved by right-clicking on it. Forms - All of the windows (forms) currently open in Confirm will be listed at the bottom of the ‘Window’ menu. The currently active window will be indicated by a tick. Click on a Window name in the list to make it the active window.</td>
</tr>
<tr>
<td><strong>Help:</strong></td>
<td>‘Confirm Help’ - Opens the online Confirm Help system. If a screen is currently open, it will open at the relevant page. ‘Contents and Index’ - Opens the online Confirm Help system at the welcome page. ‘Contact Confirm Support’ - Opens the Pitney Bowes Confirm self service portal. ‘About Confirm’ - This option displays the Licence the User is currently logged into and displays the version of Confirm which is installed.</td>
</tr>
</tbody>
</table>

**Toolbar**

The Toolbar (called the Framebar) includes standard Windows buttons such as Cut, Copy and Paste which can be used when editing Confirm data. Additionally it contains the following:

| **Undo:** | Undo: Undoes the Users previous keystroke. |
**Note:** This will not be able to undo a change that has been saved.

**Send:** Sends selected records from the current form to an email address.

**View as PDF:** Converts the current record or screen into a PDF document. Ensure that the required screen or report is active and select this button or File | 'View as PDF' . The PDF conversion will take place and the results will be displayed in Adobe Acrobat Reader.

**Explorer:** Launches the Explorer if it is not already open.

**Dashboard:** (Dashboard module)

Launches the Confirm Dashboard. If the current User has not specified a Dashboard then the Dashboard User Settings will open.

**Internal Messages:** Launches the Internal Messages screen for the current User. This icon is only visible if the User has at least one of the Confirm Alerts modules activated and if their User ‘Message Preference’ is set to send messages to the Confirm Internal Messages screen.

**Alerts\Internal Messages Button**

**User Specific Tools**

Any menu options that the User has dragged into their User area will be displayed as icons on the toolbar.

**Return to Login:** Logs out the User without closing Confirm. The login screen is displayed to allow the User (or another User) to login again.

**Exit:** Logs out the User and closes Confirm.
Customising the Toolbar

The toolbar can be customised in the following ways:

To move the Toolbar

Right click on the toolbar to display a menu of display options. Select from the available options to move it. Alternatively, the toolbar can be dragged into the location that User wishes it to be located.

Note: These changes are User specific and Confirm will remember the location of the toolbar for each User.

To add buttons

Drag icons from the 'Main' section of the Confirm Explorer, into the 'User' section. This will place a copy of the icon, as a button, on the toolbar.

Note: These changes are User specific. Each User may customise their toolbar, and will see their own toolbar wherever they login to Confirm.

If the User wishes their customised area to open by default (rather than 'Main'), then they can create a Folder in their User Area.

To restore the Toolbar

If the toolbar has been removed from the view, it can be restored by selecting the 'Framebar' option from the Window menu. Alternatively dragging any icon from the 'Main' section of the Explorer, into the 'User' section will also restore the Toolbar automatically.
The data entry forms, utilities and reports within Confirm are held as options and folders in the Explorer.

The Explorer has three Sections:

**Main**

Provides all the data entry forms and folders that are available to the currently logged in user. The folders that can be seen are regulated in two ways:

- **Modules available** - The user will see only the folders and forms that relate to the modules 'switched on' in Confirm.
- **User privileges** - The user will see only the folders (within the modularity described above) that they have been granted rights to in the User Security screen. Please see the 'System Administration' manual for details on setting User privileges.

**User**

A user specific section into which each user may copy folders and forms that they regularly use. The User section is uniquely configurable for each user and each user will view only their User section.

To copy folders or forms into the User section click and drag a folder, or icon, from the Main section of the Explorer. New folders may be added by right clicking over the User section, and selecting 'New Folder' from the fly-out menu.

**Group folder**

A Group specific folder, displaying folders and form options for the Group. Users who have rights to edit Groups Securities will see all the Groups displayed as sections, and will be able to customise those Group sections by adding folders and forms. Users who do not have rights to edit Group Security will see only the Group to which they belong, and will not be able to add folders or forms to the Group.

**Using the Explorer**

When Confirm is opened there is a 'Confirm Explorer' tab visible on the left hand side of the screen (as shown above). Moving the mouse over this will expand it to show the full Confirm Explorer. The Explorer will collapse automatically when not in use so as not to take up space on the screen.
The behaviour of the Confirm Explorer is very similar to the Windows Explorer. Click on the ‘plus’ (+) icon, or double click a folder, to expand it. Double click an icon to open the form. Click on the ‘minus’ (-) icon, or double click the folder again to collapse it again.

When a form is opened by double clicking its icon (also by pressing the enter key while the menu option is selected), the Explorer will collapse, and the tab on the left will reappear.

**Note:** A form can also be opened by right clicking and selecting 'Open' from the popup menu. This will open the form but not collapse the Explorer, making it possible to open several windows at once.

It is possible to close the Explorer completely by clicking the X button in the corner. It can be reopened by selecting Explorer on the toolbar or on the Shortcuts menu.

### Pinning the Explorer

In its default mode as described above, the Confirm Explorer will collapse when not in use. If preferred, it is possible to 'pin' the Explorer open using the pin button in the corner. If this is done, the Explorer will remain at its full width and will no longer collapse when the mouse is moved away or a form is opened. The forms and reports opened by a User will appear in the area to the right of the Explorer. It is possible to 'unpin' the Explorer at any time using the same button.

**Note:** Confirm will remember in between sessions whether the Explorer is open, pinned or closed for an individual User.

### Finding a Form

The File menu offers a Find option. Select this, and type in a search word, or words. All the forms and utilities that contain the word(s) will be displayed. Double click the one you want, and the explorer will open the relevant folder(s) and highlight the form or utility.

### Setting a Home Page

A Home Page can be set by any User by right clicking on an item in the Explorer Window, selecting 'Set As Home Page'. Once set, the item set as the Users Home Page will open automatically when Confirm starts. By default the Home Page item opens instead of the Explorer Window, however a [General System Setting](#) is available to specify that the Home Page should open in addition to the Explorer Menu rather than as an alternative.

### User Interface

Confirm can be configured to display Data Entry Forms in two ways:

#### Tabbed
Data Entry Forms will launch in a tabbed layout as shown above. Each tab may be dragged out of the tab bar, changing them to a floating window which can be moved outside of the main Confirm application window.

Filters will launch as a floating windows centered on the parent tab.

Filter lookup (results) windows will open as a floating window and the default height has been changed to allow more of the list to be displayed.

Pick buttons launch the request as a floating window and centered on the parent window or tab.

As a general rule, clicking on another tab will hide any floating windows not linked to the currently selected tab.

**Note:** Positions are not retained, meaning once a floating form has been closed, the next time it is opened it will open as a tab.

---

**Classic**
Data Entry Forms will launch separately cascading down from the first as shown above. These forms may not be moved outside of the main Confirm application window.

**Changing the User Interface**

To change between the two interface options, change the **Open screens as Tabs** option in the **System Administration / Security / General User Settings**.

**More Windows**

The More Windows screen is only available when Confirm is using the Tabbed **User Interface** and will list all currently opened Data Entry Forms.

It can be launched from the drop down arrow at the top right of the tab bar once multiple forms are open.
Common Buttons

The following buttons are common throughout Confirm:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record counter</td>
<td>Displays the number of records available to view and which records currently displayed.</td>
</tr>
<tr>
<td>Scroll buttons (left and right)</td>
<td>Scroll the records to the first (left) or last (right) record.</td>
</tr>
<tr>
<td>Find button</td>
<td>Recalls records into the current screen. Can either display a filter for data selection or directly display data.</td>
</tr>
<tr>
<td>More button</td>
<td>Appears on filter screens, allows more advanced filtering options.</td>
</tr>
</tbody>
</table>

The record counter is displayed on most screens and gives details of how many records are currently available to view, and which of those records are currently displayed.

The buttons on either side of the display scroll the records:

- Scroll left (left button)
- Scroll right (right button)

These buttons take the User to the first (left) or last (right) record.

- Scroll left (left button)
- Scroll right (right button)

These buttons take the User to the previous (left) or next (right) record.

The Find button recalls records into the current screen. Clicking on the Find button will either:

1. Display a filter which can be used to select the range of data required. Leaving a filter blank will bring in all the available data. Data returned by the filter will be displayed in a 'Lookup' list. Click OK in the Lookup list to display the data in the screen the Find button was clicked on.
2. Display data directly in the 'Lookup' list. This is often only the case for simple lookup screens where many records are not likely to exist.

If data was already present in the form when Find button was clicked, then that data is displayed as a Lookup list. This allows the User to move quickly to another record in the list without having to scroll through all the records in between. The User can select a new range of data by clicking the 'Refresh' button where the filter will be displayed again.

When the 'More' button is clicked, a Data Query Qualification screen will display all of the columns available on the report, entry screen or pick button the filter was opened from.

The 'More' button will display a '+' once criteria has been specified and can be cleared with the 'Clear' button.

Note: There is no link between the standard filter and the 'More' button filter. Confirm will not validate filter criteria between the two filters so it will be possible, for example, to enter a restriction to
select Site Code 'ABCD' on the standard filter and Site Code '1234' on the 'More' button filter and therefore no records would be retrieved.

**Note:** In order to see this button the current User has to have access to the 'Additional Filtering' User Security option. This option covers the security for the 'More' button on all screens it appears on.

Please see the Reporting manual for details on:

**Applying Qualifications**

**Blue bullets - Linked Columns**

**Green bullets - Unlinked Columns**

**Expert**

The New button to displays a blank form for the entry of a new record.

The List button displays the available reports and lists for the current screen. Data does not need to be currently displayed in the screen to access this button.

Please see "**Reports & Lists**" on page 33" for further details.

A Named Selection can be created anywhere the Named Selection button can be seen. This will usually be on Inventory forms, lookup lists, and report previews.

Clicking on the Named Selection button will allow the user to save the list of Features which is present in the report (if a report has been run) or lookup list (if a filter has been run). These 'Named Selections' can then be used at a later date in a filter.

**To Create a Named Selection:**

Filter the data required for a report or lookup list.

Click on the Named Selection button.

![Save Named Selection](image)

Enter a Code, Name and (optionally) Notes.

If this is a new Named Selection - click OK to save the selection.

If an existing Named Selection has been selected the User can use the 'Where Selection already exists' drop down to select from:

'Replace' - To replace the current Named Selection with the new one.
'Append' - To add the Features currently selected in the report or lookup list to the already existing Named Selection.

'Subtract' - To remove the Features in the report or lookup list from the already existing Named Selection.

Named Selections can be created by adding and subtracting Features in this way until the list comprises the required Features. The Named Selection can be viewed and edited (or created) in the Named Selection Lookup.

The 'Map' button can be used to open the Map and if there are coordinates set for point entities i.e. Enquiry, Defect, Job then Map button will appear as

Closes the current form a warning will be given if a modified record has not been saved.

Saves the current record.

Will restore the record to its appearance at the last Save. It will not 'undo' changes that has been saved.

Deletes the currently displayed record.

**Note:** It may not always be possible to delete a record because it is referenced by other records in Confirm. In this case, a warning will be given to that effect and the record will not be deleted.

Creates a new record that is a copy of the displayed record. The code of the new record must be changed before it can be saved.

Displays a drop down menu which displays the Actions that can be performed on the current record.

Displays a drop down menu that gives access to related forms and utilities.

Opens the selected record to provide further information.
Document Links

Document Links can be created to point to any file in the system, allowing relevant photographs or text documents to be associated with a record.

Click the Links button to display the Document Links form, listing the documents linked to the corresponding record. If there are already Document Links associated with the record then the Links button will be highlighted with a border.

The screen lists the currently linked files. The fields below the list give specific information about the selected Link.

Note: For Documents Links created from Street Works Notice, Inspections and Fixed Penalty Notices an extra column will be displayed. This column will notify whether this document was received via EToN or not. This column will not be displayed for Document Links on Features, Enquiry or Jobs.
To add new Links:
Click on the New button and enter the document details.

<table>
<thead>
<tr>
<th>Description</th>
<th>A free text field used to annotate the file. This field is required while publishing a document from Street Works, otherwise it is optional.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document Location</td>
<td>Enter or select the path to the required document.</td>
</tr>
<tr>
<td>Copy Button:</td>
<td>This button will copy the fully-qualified path of the Document Location to the clipboard, resolving any location prefixes.</td>
</tr>
<tr>
<td>Document Date</td>
<td>A date and time for the Link. This defaults to the current system time but can be edited freely.</td>
</tr>
<tr>
<td>Last Modified (by)</td>
<td>The date and time when this Link was last modified, and the User who made the change. This cannot be edited.</td>
</tr>
<tr>
<td>Upload to Document Store</td>
<td>This is only available if a 'Document Store Folder' or a 'Web Service URL' has been specified in the Document Link System Settings screen.</td>
</tr>
<tr>
<td>If this is ticked, the Document will be transferred from its current location to a central document store when the screen is saved. After uploading the file to a central document store the 'Document Location' value will be changed to reflect the new location of the document, and depending on the type of document store being used the location may be prefixed with either '$Document Store$' if the central document store is set to 'Folder', or '$Document URL$' if set to 'Web (PUT)' or 'Web (POST)'. This prefix will be applied to all links uploaded to a Folder document store, but this may not be true for a 'Web' document store if no part of the returned URL matches the 'Document Link URL Prefix'.</td>
<td></td>
</tr>
<tr>
<td>For more information on Document Stores see Document Link System Settings.</td>
<td></td>
</tr>
<tr>
<td>Delete Original File after Upload</td>
<td>This is only available if Upload to Document Store is ticked.</td>
</tr>
<tr>
<td>If this is ticked, the local file will be deleted after it has been successfully transferred to the Document Store.</td>
<td></td>
</tr>
<tr>
<td>Download</td>
<td>Allow to browse to an accessible location and download the attachment.</td>
</tr>
<tr>
<td>Identification Image</td>
<td>This is only available when viewing Feature Document Links, where the Feature belongs to a Feature Group for which an image is shown on the Feature screen.</td>
</tr>
<tr>
<td>By default, the first appropriate Document Link in the list will be used as the image. This field may be ticked to override this behaviour and choose a specific image for display. The Description of the Document Link record will be updated to show that this has been done.</td>
<td></td>
</tr>
<tr>
<td>For more details see Feature Identification Image.</td>
<td></td>
</tr>
</tbody>
</table>

Once the details for one or more Links have been entered, click Save to store the details.

**Document Location Prefixes**

If a document was selected for transfer to a central document store, or was a Street Works link that was published, then part of the path or URL to that file is often replaced with a prefix. There are several prefixes in use and each has a different value.
System Fundamentals

<table>
<thead>
<tr>
<th>$Document$</th>
<th>This is used for photos uploaded from a hand held device via the Confirm connector. Its value is equivalent to the 'Document Store Folder' setting in the Document links System Settings screen.</th>
</tr>
</thead>
<tbody>
<tr>
<td>$Document Store$</td>
<td>This is used for documents uploaded to a central document store that is set to be a 'Folder' type. Its value is also equivalent to the 'Document Store Folder' setting in the Document links System Settings screen.</td>
</tr>
<tr>
<td>$Document URL$</td>
<td>This is used for documents uploaded to a central document store that is set to be a 'Web (PUT)' or 'Web (POST)' types. Its value is also equivalent to the 'Document Link URL Prefix' setting in the Document links System Settings screen.</td>
</tr>
<tr>
<td>$ORG_PREFIX$</td>
<td>This is specific to Street Works document links and is used when a document is Published. It's value is dependant on the Organisation that the document link is related to. The value is equivalent to the 'Attach. URL' setting in the Organisation screen, for the Organisation that the link is related to.</td>
</tr>
</tbody>
</table>

To modify an existing Link:
Click the link in the list and modify the Description or Document Location as required, then click Save.

To view a currently linked file:
With the required file highlighted, click on the 'Launch' button. The associated program is launched and the file displayed.

To delete a Link:
Click the link in the list, then click the 'Delete' button. The link will be removed from the list, but the file will not be deleted.

Security of Linked items:
There is a generic User Security option which can be used to selectively prevent Users from either adding, deleting or modifying (e.g. changing the Description or Document Location) items linked to entities in Confirm. This option appears in the Security section of the menu when configuring privileges on the User Security and Group Security screens.

Document Links in Street Works
The document links feature within Street Works has extended functionality. Refer to the document links section of the Street Works help for more information.

Street Works\Document Links
Problems Uploading to the Document Store

Problems may be encountered when using the 'Upload to Document Store' setting, especially when using a web service document store, where the document may travel across a network to an external application.

If problems do arise then any changes made to the document link details, such as dates and description, will still be saved to the Confirm database, however the document link will not be updated and the document will remain in its original location. It will not be deleted, even if 'Delete Original File after upload' was selected.

Uploading to a Web Service is highly dependant on external applications, and it is not possible for Confirm to interpret all of the possible errors that may arise once the document is sent out. If an error does occur then Confirm will display "Failed to upload - the following error was returned by the Web Service:" followed by the error message that is returned to it from the external application.

How Data is Displayed

Data Entry Form

Each option from the Explorer will open in a separate window. Several windows can be opened and they can be arranged by the user or by using the 'Window' Menu. The title bar gives the name of the form or filter on the left hand side. On the right hand side are the Windows Minimise, Maximise and Close buttons.

Upper tabs

The information on some forms is kept on several sheets or 'tabs'. The other sheets of information are accessed by clicking on the relevant tabs. Where the tabs are found at the top of the form, clicking on a tab displays another portion of the form.
Lower tabs

Where additional data can be made and linked to another record, the information will be held on tabs on the screen.

To add data, or amend data, select the required tab by clicking on it, and then click on the 'Detail' button.

Note: The User will be required to save the main record before they can open a lower tab.

A sub-form will be displayed, in which related data can be held as separate records. The sub form follows the same conventions as the main form.

Each record that is added becomes a line, which can be seen on the tab. Scrolling through the records moves the highlight on the tab up and down the list.

Close the sub-form to return to the main form.

Subsidiary data forms

In addition to the main forms that can be accessed by clicking on the relevant icon in the Explorer, Confirm contains 'forms within forms' which store additional data.

Simple forms can be found on lower tabs. More complex forms, allowing multiple entries, can be found by clicking on the 'Other' button in a main form and selecting an option from the drop down menu.

Multiple record forms

These forms allow the storage of multiple records against the one main record. All the records present in the main form can be scrolled through at this level, allowing the user to view this category of information, for all the main records present, without having to exit this form to return to the main form and scroll forward to the next record.
Within these forms, records are added, one by one, and accrue to a list that can be seen in a separate pane.

**To add data:**
The entry fields will usually be found at the bottom of the form. Select the options from the pick lists, or drop down lists. Click on the 'Update' or the 'Add' button to add the new record to the list.

**To delete data:**
Select the record in the list, and click on the 'Delete' button.

**Confirm Wizards**
Wizards are available in Confirm which allow a User to create a record by guiding them through the steps needed to populate the fields. Once a wizard is complete, a read only version of the record which has been created is displayed. These are different to conventional Confirm Data Entry forms where Users directly type into the screen.

**Confirm Wizard buttons**
The Confirm Wizards have standard buttons which appear at the bottom of each step. These buttons will be active/inactive where appropriate e.g 'Back' will never be active on the first step of a Wizard.
<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Next &gt;</td>
<td>Select this to progress to the next step in the wizard.</td>
</tr>
<tr>
<td>Finish</td>
<td>Once the required fields have been provided, the ‘Finish’ button will be active. Select this to complete the wizard and create the record in the database.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Select this to Cancel the current wizard.</td>
</tr>
<tr>
<td></td>
<td>Note: Confirm will prompt the User to confirm that they want to cancel the wizard as all data entered into the wizard so far will be lost.</td>
</tr>
</tbody>
</table>

Types of Fields

Code fields

Each record has a unique code, which, once entered and saved, is not editable. When entering codes, the text will appear in upper case regardless of whether Caps Lock is engaged or not.

The code field may be used to recall existing records by typing in an existing code and pressing the tab key. This will recall the record that carries that code.

Date / Time fields

Date fields can be populated or updated in one of two ways:

- Type the date within the field.
- Double click in the date field or use the F4 function key to display a calendar-style date screen. Today’s date will be selected by default but another date can be selected. Use the arrow buttons at top left and right to scroll through the months. Use the Today button to change the current date to today’s date. Use the ‘None’ button to clear the date entry.

Where appropriate, the calendar will show Hours and Minutes fields, which may be updated by direct entry, or by selection from the drop down. Use the ‘Now’ button to enter the current time.
Note: In some cases date fields are automatically updated as a result of actions carried out in other parts of the system.

**Drop down field**

A drop down field has an arrow button at the right hand side. These fields can only have entries from a lookup. The drop down provides the opportunity to view that lookup to make a selection.

Click the arrow button to view the lookup contents as a drop down list. Select from the list by clicking on the required entry to place it in the field.

Drop down fields can also be completed by typing the description, or part of the description. As soon as the entry is recognised, Confirm will complete the entry from the lookup list.

Drop down fields will usually be mandatory - i.e. data must be entered before the record can be saved.

**Free Text field**

A free text field does not reference a library or lookup, therefore the User can type in any text they choose. Free text fields vary in size. For external references or ID numbers they allow the entry of 10 or 15 characters.

The larger free text fields are referred to as **Notes fields** can be further expanded by double clicking in the field.
Notes field

Notes fields are large free text fields used for comments, descriptions or locations which can allow entry of text, usually two thousand characters in length but may vary depending on the field. They can be further expanded by double clicking in the field. This displays a text entry box which will automatically resize depending on the content. Text can be entered directly, or the 'Insert' button can be clicked to select pre-defined blocks of text from the Comment Library Lookup. Once the entry is complete click OK in the text entry box to close the box and place the text into the originating field.

![Notes field example](image)

Pick Fields

A pick field has a 'Pick' button at the right hand side. These fields usually only allow entries to be made from a lookup. The pick button provides the opportunity to view that lookup to make a selection.

Clicking the pick button usually displays a filter. Enter the filter parameters, or leave the filter blank to display all records. Click OK to display the Lookup list. Select the required entry from the lookup list and click OK to place it in the field.

Pick fields can also be completed by simply entering the code or the description.

Pick fields will usually be mandatory - i.e. data must be entered before the record can be saved.

Note: Enter the first part of the description, and press the tab key, to display a lookup list comprising of all the library entries that begin in the same way.

Reports & Lists

Reports and Lists may be produced in two ways:

1. By selecting a specific item in a Report folder on the Explorer.
2. By clicking on the 'List' button on a data entry screen.

If the 'List' button is used, a choice of list types may be offered (depending on the screen the button is selected:}
Where the Reporting module is present, the list will include any custom report created in the Reporting module for which the data source specifies a link to this entity on the Linked Tables tab.

Select the Report or List required and click the OK button.

**Report Previews**

Whether the starting point is the 'List' button on a screen, or Report item from the Explorer, the next step will usually be to complete a filter, setting out the filter criteria.

The type of filter, and the range of filter options, will vary according to the area you are reporting on.

All report filters carry the option to 'Preview', which is checked by default. If this is unchecked, the Report will be sent straight to the default printer without preview.

**Previewing a list**

When OK is clicked on the filter, and 'Preview' is checked, the preview will be displayed in a preview window.

The following functions are available:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Preview:</td>
<td>This option allows the user to view the report, as it would appear when printed with the blue border representing the margins. Clicking on the Print Preview mode activates the 'Rulers' and 'Zoom Out / In' buttons.</td>
</tr>
<tr>
<td>Rulers:</td>
<td>This option will put horizontal and vertical rulers on the page. The rulers carry margin marker that can be dragged to adjust margin width. Click the 'Rulers' button again to switch off rulers. Rulers are only available when in Print Preview mode.</td>
</tr>
</tbody>
</table>
The zoom buttons allow the user to adjust the view of the page. The Zoom buttons are only available in Print Preview mode.

Print: Click to send the report to the Windows default Printer.

Save to file: Click to display the 'Save As' dialog. The information in the list can be saved in any of the formats listed in the 'File Format' list.

Copy: Click to save the information in the list to the users clipboard. The data can then be pasted into another Windows program.

Re-Filter: Click to display the original report/list filter again. New filter criteria can be entered and the report can be run again.

Named Selection: Feature based reports can be saved as a 'Named Selection' which can then be used in other filters which display the 'Named Selection' field.

The Dead flag

Records that cannot be deleted because they reference other data, or because they may be required again later, can be flagged as 'Dead'.

To make a record dead: check the Dead flag and save the record.

The record will not now appear in lookup lists, unless 'Dead' records have been specifically requested in the filter. 'Dead' records will be excluded from any processing applied to these records.

To remove the Dead flag from a record: filter in the form for 'All' or 'Dead' records. Select the required record and remove the check on the Dead check box. Save the record.

Importing and Exporting Data

Confirm has many places where imports and exports can be performed. These places allow the User to select a location to import from / export to. To aid the User, the pick button will remember the last directory accessed for that purpose, and default to there rather than to the current Windows directory. Confirm will remember the last import and export directory separately for each User.

Shortcut keys

Many of the Confirm functions can be accessed using the keyboard instead of the mouse. Most of these shortcuts are standard Windows shortcuts - but a few are unique to Confirm.

Menus

Alt + [underlined letter] Opens menu list. For instance type Alt + W to display the Window menu list

Left \ Right arrow keys To close the currently open menu list and move to the next (left or right) menu list.

Up \ Down arrow keys To move the highlight bar up or down a currently open menu list.
Enter key To select the currently highlighted menu item

[underlined letter] Selects a menu item. For instance, with the Windows Menu list displayed, type 'n' to select Minimise All

Esc To close currently displayed Menu lists

Standard Shortcut keys These are displayed in Menu lists after each menu entry which has a standard shortcut. For instance, the Help Contents option in the Help menu gives Ctrl+F1 as the keyboard shortcut for the Help Contents.

Toolbar

Ctrl + Alt + F10 Returns to the Login screen. Equivalent to clicking on the ‘Coffee Cup’ - Take a Break button.

Ctrl + E Displays the E-mail Window. Equivalent to clicking on the 'Send' button in the toolbar

Confirm Explorer

Up \ Down arrow keys Moves highlight up and down the Explorer list

Left \ Right arrow keys Opens \closes the currently highlighted folder.

Enter key Opens the currently selected form, utility or report filter (but not folders).

Forms

Ctrl + F Displays the Find filter or the Lookup list. Equivalent to using the ‘Binocular’ - Find button in the Form’s Toolbar

Ctrl + L Displays the List filter, or ‘Select List’ screen. Equivalent to using the ‘Printer’ - List button in the Form’s toolbar

Ctrl + N Displays a new, blank, form. Equivalent to using the New Page button in the Form’s toolbar

Alt + [underlined letter] For button functions such as: Restore, Delete, Other.

Enter Activates the 'Live' button (that is: the one which has a heavier black outline). Since this is usually the 'Save' button the result of pressing the Enter key is usually to save the currently displayed record.
Ctrl + Enter Breaks onto a new line in a text entry box.

Page Up \ Page Down In a blank data entry form: use Page Up or Page Down keys to bring up a filter (if the window has one) or retrieve all records (if the window doesn't have a filter)
In a populated data entry form: use Page Up or Page Down keys to scroll forward or backward through the records. Equivalent to using the scroll buttons

Forms & Filters

Tab Moves to the next field
Shift + Tab Moves to the previous field
F4 Display the drop down list, or pick list filter in the relevant fields.
F6 Move to next open tab\Window
Up \ Down keys Moves the selection up and down a drop down list or pick list.
Enter Selects the currently highlighted drop down or pick list item.
Space Bar Toggles the check-box selection. Equivalent to clicking in a check box.
Ctrl + Shift + F1 Displays the current Window name. This information may be useful when logging an issue with the Confirm support team.
Esc To close the form. Equivalent to the 'Close' button.

List Previews

Ctrl + P Prints the currently displayed list or report. Equivalent to clicking on the 'Printer' button in the preview window toolbar.
Ctrl + C Copies the currently displayed list or report information to the Windows clipboard. Equivalent to the clicking on the 'copy' button in the preview window toolbar.
Page Up \ Page Down Scrolls up and down the list or report. Equivalent to using the scroll buttons.
Esc To close the preview window. Equivalent to the 'Close' button.

Session Logging

Ctrl + Shift + L Prompts for a filename then saves the last 1000 entries from the internal session log to the provided file. This file can then be opened in a text editor. The session log is also reset after the save operation.
Ctrl + Shift + S Prompts for a filename and then all session logging is recorded to that file until the end of the current session. If the shortcut is used when session logging is already active then Confirm will display the name of the session logging file.

Warnings and Errors
Confirm will issue warning messages when a User is about to carry out a procedure that will prejudice existing data (move on without saving for instance), or when they are about to carry out an irreversible procedure (giving an option to back out if they 'clicked' in error).

Any message will give the options of clicking 'Yes' or 'No' where a User is asked to make a choice, or OK where the message is giving information.

Error Report Form
Very occasionally, an error will occur which will cause Confirm to close down. In this case an Error Report Form will be displayed:

The User can either Print the Error Report Form or send it via email.

In either case, the User will be prompted for a description of what they were doing when the error occurred. This description will then be included on the printout, or in the email message.

The destination for sending via email will be a local administrator if a Support Email Address has been specified on the General System Settings screen. If no Support Email Address has been specified the email will be sent to Confirm Support.

Confirm will then exit when the OK button is pressed.

Reset Sessions
There may be occasions where a System Administrator may reset the Users Confirm session whilst they are still logged in. If this is the case, Confirm will display a warning message. The message asks if they want to attempt to log back into the system.

If the 'Yes' button is clicked, Confirm will log them back into Confirm without sending them back to the Application Login screen, and they will be able to continue with their work.

If the 'No' button is clicked, Confirm will close and the User will need to start Confirm again.

User Session Lock
User Session lock: User session will be locked if User inactivity exceeds the Inactivity timeout specified in Security settings. User can unlock the session using their password.
While the session is locked, any background tasks will continue to run to their completion. Hitting 'X' button will close the application.

**Changing Password**

**Changing Your Password**

The Change Password option is found in the Security folder of the System Administration folder in the Explorer. If the System Administrator has set a Users password to expire after x number of days, the Change Password form will automatically open the next time they log into Confirm after the expiry date.
To change password, the User should follow the steps below:

- Enter their Current Password
- Enter a New Password
- Re-enter the new password in the 'Confirm New Password' field.
- Click the OK button.

**Exporting Data from Confirm**

**Print Screen**

To print the contents of the current Confirm session, select 'Print Screen' from the File menu or press Ctrl+Alt+P. This will allow image to print.

**Sending Data**

Records selected within a Confirm screen or report can be sent to a mail recipient as an email attachment. To send data, follow the steps below:

- Retrieve the records to send.
- Either click the 'Send' button on the toolbar or select Send (Ctrl+E) from the File menu.
- Amend the Subject if necessary.
- Select the format of the attachment.
- Click the 'Addres.' button to select the addressees.
- Click 'Send'.

![Email Window](image-url)
Logging Out

To log out and close Confirm the User may do any of the following:

• Select the Close button from the top right hand corner of the screen.
• Double click on the Control Menu box from the top left hand corner of the screen.
• Select the 'Exit' option from the File menu option.
• Press Alt + F + X.

Note: These options exit Confirm completely. If the User simply wants to return to the Application Login screen, select the 'Return to Login' button.

This can be done at any time, no matter what programs are currently running. If there is any data entered or changes made that have not previously been saved, Confirm will prompt the User with the relevant warning message and provide the opportunity to change their mind or continue.

Taking a Break

If the User will not be working in Confirm for any period of time, it is recommended that they return to the Application Login screen. This will log them off as a current User without closing Confirm and free their licence to be used by another User. They will need to re-enter their password to log back in.

To Log out:

• Click the 'Return to Login' button.
• The Application Login dialog is displayed.

To log back in:

• The User ID will already be displayed - this can be changed to log in as another User.
• Supply a password.

Click OK or press Enter. This can be done at any time, no matter what programs are currently running. If there is any data entered or changes made that have not previously been saved, Confirm will prompt the User with the relevant warning message and provide the opportunity to change their mind or continue.